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Welcome to the latest edition of my monthly Final Cut Studio newsletter for September,
2010.

The goal of this newsletter is to provide information helpful to the interested
user of Final Cut Pro. This newsletter publishes each month, past issues are
available in my store. All software references are to Final Cut Studio (3) unless
otherwise noted.

Please invite your friends to visit my website -- www.larryjordan.biz. There
you'll find daily tips, the latest industry news, and over 500 articles and tutorials
to help you get the most out of Final Cut Studio!

If you haven't done so already, each issue of this newsletter is FREE -- subscribe here.
Then, follow us online.
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WRAP-UP

WELCOME

September seems to be flying by -- Digital Video Expo is rapidly
approaching -- and there is so much I want to chat with you about.

The weekly deadlines of my webinars mean that I am constantly
discovering new ideas, technology, and techniques. So much so, that
there just are not enough hours in the week to share with you
everything I'm learning. I've got a lot of great new stuff in this
newsletter, but for the latest insight on techniques and technology,
my weekly webinars are the best place to look.

Our new Finall Cut Studio Forum is continuing to gain interest. This is a great place to visit if
you have questions about Final Cut Studio. It isn't overwhelming like the larger forums,
which means that it is often easier to get questions answered there. I visit it regularly to
make sure that every question in it gets a personal answer.

This month, I've got hardware reviews, software reviews, and a lot of philosophical thoughts
on a variety of subjects to share with you. As always, I enjoy reading your comments and
suggestions -- even when you disagree. Please keep sending them in -- anything that is
relevant to the subjects in this newsletter will be added as updates.

It is good to be back writing to you again. So, with that being said, let's get started.

[ Go to Top. ]

APPLE RELEASES UPDATES TO FINAL CUT STUDIO

A few days ago, Apple updated many of the
applications in Final Cut Studio. These are,
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essentially, bug fix updates. They still have not
added full support for Snow Leopard. Final Cut
Pro, Motion, Compressor, and Color were all
updated.

The update is free and available via Software
Update.

My general suggestion on updates is to always
wait a few days to make sure there are no
hidden complications.

As I'm writing this newsletter, I'm updating one of my systems because, so far, I have heard
nothing bad about the update. So my feeling is that it should be safe to install it.

[ Go to Top. ]

DIGITAL PRODUCTION BUZZ IS THE OFFICIAL PODCAST OF DV EXPO

For the third year in a row our podcast -- Digital Production Buzz -
- is the official podcast of Digital Video Expo. This conference and
trade show event starts September 28 in the Pasadena
Convention Center.

Our coverage of DV Expo this year is a bit different - we are
offering two FREE LIVE WEBINARS from the show floor for the
first 75 people that register, as well as three special editions of
The BuZZ.

Regarding these DV Expo Specials, we are interviewing key industry people live on the show
floor and presenting them in a series of one-hour specials posted each night. So, like we did
at NAB, we are setting up a production studio at the show. (For more about this, see my
review on the Drobo FS, below.)

Click here to learn more about the FREE LIVE WEBINARS.

Click here to learn more about our DV EXPO SPECIAL COVERAGE.

Our special coverage of Digital Video Expo is made possible by
Data Robotics and their Drobo line of products. We are very
grateful for their support.

[ Go to Top. ]

LARRY'S WEEKLY WEBINAR UPDATE

As you read this, I'm getting ready to present our 14th webinar:
Growing Your Business. These weekly, one-hour live programs
have generated a lot of very positive comments and interest. Thanks!

(By the way, if you want to learn how to improve your sales
and marketing, you need to watch this session!)

When we were designing these weekly sessions, I wanted to find a
way to deliver high-quality training anywhere in the world at an
affordable price. I wanted to give you a way to ask questions and get

them answered live and in real-time. Finally, I wanted to provide information that cannot be
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easily found anywhere else.

This last goal is the hardest for me. I will often spend three or four weeks researching the
information that gets packed into each session. I try not to rehash existing material.

Instead I want to help you clearly understand the subject matter, show you ways you can use
it, and give you the skills you need to learn more about it on your own. In every webinar
we've produced so far, I have also included relevant late-breaking news along with the rest
of the material, along with additional resources that you can study on your own.

If you haven't attended a webinar yet, visit our store and check out the FREE DEMOS
associated with each webinar. These two-minute videos outline what each webinar is about
and gives you a better understanding of my presentation style.

By the way, we are running a promotion that allows you to qualify for free webinar tickets.
Click here to learn more.

Timely, affordable, in-depth, and easy to watch -- plus, you can attend from the comfort of
your own computer.

Click here for a list of all available webinar titles.

Click here for a list of upcoming live events.

[ Go to Top. ]

THOUGHTS ON STEREOSCOPIC 3D VIDEO

I just finished working on a webinar which totally
changed my thinking on 3D video - stereoscopic 3D, if
you want to be technically correct.

While there isn't space to go into everything I learned, I
do want hit a few highlights. If you want more details, or
a detailed demo of working with stereoscopic 3D in
Final Cut Pro, check out the webinar here.

Here's my current thinking. Whether 3D is a flash-in-
the-pan or the long-term savior of theatrical films
doesn't really matter. Currently, Final Cut editors can get into 3D for $99 using the
Dashwood Studios Stereo 3D Toolbox LE plug-in.

That, plus a couple bucks for some anaglyph glasses, (those red/cyan ones) and you can get
started. Yes, you can spend more money, but you don't have to. Not yet.

Since YouTube is now distributing 3D movies, you have access to a free distribution
mechanism.

This means you can go back to clients that haven't been talking to you in a while, and pitch
them on the idea of doing 3D promotional work for the Web.

They get a marketing opportunity and the ability to brag about being "state-of-the-art" and
you get a paying gig, with someone else paying you to learn how to edit stereoscopic 3D.

Then, as more client dollars start to come in, you can buy the higher-end software and
monitors you need for serious work.

If 3D takes off, you are on the leading edge and positioned to grow with it. If it dies, well,
you were making money with it while you could.
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ONE MORE THING

Here's the other idea to keep in mind. Stereoscopic 3D video is simply two full-screen video
streams running at the same time - just like a multiclip.

So, the process of editing 3D is just like the process of editing 2D - except you are editing a
fancy form of a multi-clip.

In other words, the step from where you are now to getting started with 3D is not as big as
you might think.

Now before experienced 3D professionals bombard me with emails saying: "Uh, hey dummy,
it isn't as easy as all that!" let me hasten to add that 3D is both as simple and as complex as
lighting. If all you want to do is practice shooting with a camera, you can hang a light in a
room and start shooting. But getting great lighting takes time, practice, and understanding
the craft. 3D video is similar. It is easy to get started, with incredible depth (pun intended) to
explore as your time, budgets, and projects permit.

For everything you need to know to get started, watch my webinar. Anything that gives us a
chance to pitch for more work is a good thing in my book.

NOTE: As an example of how to take advantage of this opportunity, the Sept.
23 episode of the Digital Production Buzz has an interview with Terri White, a
wedding videographer, who is now shooting weddings in 3D. During the
interview we'll find out why she's doing it and how her market has responded.

[ Go to Top. ]

PRODUCT REVIEW: DROBO FS BY DATA ROBOTICS

{To read my disclosure policy on product reviews, 
please click here.)

This week has been an interesting combination
of getting our production gear ready for Digital
Video Expo and thinking about the business of
our business for my next webinar: Growing
Your Business.

As we do at DV Expo each year, we set-up an
audio production studio to record and edit
interviews, as well as produce a new show every
night.

(To see our guest list, or listen to these live
shows, click here.)

In the past, we've taken a server and plenty of RAID storage to track all our files. This year,
we are doing something different. When the folks at Data Robotics expressed an interest in
sponsoring our DV Expo coverage, I asked about borrowing a Drobo FS to use for the show.

I've been a fan of Drobo for a while. The security it provides by being a RAID, its
expandability, and its flexibility make it a strong contender when considering adding storage
to your system.

Here is a list of my past reviews of Drobo gear:

Drobo
Drobo S
Drobo Pro
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Drobo Elite

The reason I wanted to use the Drobo FS for the show is that this unit includes its own file
server. In other words, I don't need to bring any other computer gear to share files.

The Drobo FS arrived two days ago. I unboxed it, slid in some hard disks (which can be
purchased either with the unit or separately), plugged it into AC power, and connected the
Ethernet cable to my switch.

Done.

(I was reminded of the Jeff Goldblum ad for Macintosh a few years ago: step one is plug it
in, step two is connect it to the network, and (giggle) there is no step three.)

Because I've already installed Drobo Dashboard on several of my computers during testing of
other Drobo products, after a couple minutes warming up, the Drobo FS quietly appeared on
my desktop, ready to work.

No configuration, no setup, it just worked.

DROBO BENEFITS

Drobo takes a different approach when compared to other RAIDs that I've tested.

First, you can mix and match hard disk sizes. Other RAIDs require all hard disks to be the
same size.

Second, you can add more hard disks later. While the Drobo FS can hold up to five drives,
the minimum you need is three. (Drobo says you can start with two, but you won't get the
speed you need until you have at least three.)

http://www.larryjordan.biz/articles/lj_review_drobo_elite.html


Third, you can increase the size of your storage at any time, by replacing a smaller hard disk
with a larger one. Your data will be automatically rebuilt onto the new drive, even while you
are using it. In this case, I would replace the 320 GB drive with a 1 or 2 TB one.

Fourth, the Drobo Dashboard, which is how to configure and adjust any Drobo, does not
assume you have an IT degree. It is graphical, easy to use, and gets out of your way when
you don't need it.

IF YOU ARE NEW TO DROBO

If this is your first Drobo, you will need to install the Drobo Dashboard in your Applications
folder before you will see the Drobo FS. The software is free --
www.drobo.com/support/updates.php -- and takes about five minutes start to finish.

Drobo FS was designed to work with its default settings, so once you have the Dashboard
installed, you don't need to do anything else to get the unit to appear on your desktop.

You can, however, start Drobo Dashboard at any time to admire the pretty graphics.

http://www.drobo.com/support/updates.php


Drobo FS supports Windows, Mac, and Linux systems. You can also use it to create
backups for every system on your network or have it act as a Time Machine backup.

WHAT IS THE DROBO FS GOOD FOR?

The best use of the Drobo FS is for shared storage in a NON-production environment. In
other words, this is a perfect device for business documents.

When I first started it, I decided to see how fast it was. So, I copied 500 GB of files up to the
unit. (I had an ulterior motive… I had a 2-drive RAID 0 unit with a failing power supply and I
needed to be sure I had a backup.)

Data transfer speeds were 27-31 MB/second. Plenty fast enough for most business files
(which are only a few MB, if that) but too slow for massive video files. Essentially, it
transferred data about the speed of a FireWire 400 drive.

Then, I decided to transfer data to it simultaneously from two different computers - a MacPro
and an iMac.



In this screen shot you see the transfer speed from two different computers simultaneously
writing to the Drobo FS. And I discovered two very interesting things:

1. The data transfer rate of 27-31 MB/second is the maximum. As more computers send
data the rate gets divided between the devices.

2. As large files are transferred, the transfer rate pulses - slowly changing from full
speed to near zero then back up to full speed.

In this screen shot, you can clearly see the decrease in data rate even thought the file
transfer was not complete.

So, I sent an email to Mark Fuccio, Senior Director of Products and Markets, at Data
Robotics, asking what was going on. He replied:

"This is a fascinating illustration of differences in protocols. DroboPro and
Drobo FS use the same microprocessor. You see the performance differences



in your testing. iSCSI [used by the DroboPro] is a block level protocol, slinging
bytes and bytes of data between the Mac and drives. It's very fit and fast.
Drobo FS [uses] a file sharing protocol. There is a lot of computation overhead
needed [by the Drobo FS] to both keep track of the files and then manage the
communication to the host."

I then asked Mark what he views as the key market for the Drobo FS. He replied:

"There is no way Drobo FS is fit for editing (unless you have a machine to go
back in time and do SD video). Its role is for sharing files for office use, OR for
modelers doing motion graphics work. General file backup, too. It might be
useful storing a "demo reel" of finished work. I suspect most editors will find its
performance too slow to want to backup video assets from their projects."

I agree with Mark's assessment. The performance of the Drobo FS is not adequate for
editing. BUT…

Look at how many files your business creates that are NOT related to production: sales,
marketing, accounting, legal. etc. The current way to solve this is to buy a server, then buy
additional storage, perhaps even an external RAID.

I currently use three MacMini's as servers in our office which are shared among 11 systems.
I spent about $1,500 per server, plus more money for storage, yet all I'm using two of the
servers for is file sharing.

You can buy an empty Drobo FS for $664 (US list), or fully populated with 10 TB of RAID
storage for $1,614 (US list).

Essentially, you are buying the storage and getting the server for free.

So, when you are looking to expand storage and accessibility in your office, consider using
the Drobo FS. Drobo's website says "It's all about sharing." Perhaps. But for me, the Drobo
FS reminds me of my Mac: It Just Works.

Oh, so why are we using the Drobo FS for DV Expo? Because we are only
working with audio files. Most of our interviews involve only two people, with a
maximum of three. Two simultaneous audio streams at 16-bit, 44.1 kHz (which
is the rate we record at) is less than three megabytes per second. Even with
three editors working at once, the Drobo FS is plenty fast enough - plus, I get
to leave my server at home.

[ Go to Top. ]

TECHNIQUE: WORKING WITH SUBCLIPS

I was answering some reader questions in my Forum (www.larryjordan.biz/forum) about
subclips and went to look up an article on subclips I thought I had in my website library
(www.larryjordan.biz/articles). Only to discover that I've only written once, very briefly, about
subclips!

Hmmm… Well, let's fix that this month.

Subclips are used whenever you want to create a shorter clip from a longer one. The benefit
to using subclips is that they don't create any new media on your hard disk, but make it
much easier to work with longer clips.

A subclip acts just like a regular clip, except that it shares its media with the master file from
which the subclip was taken.

http://www.larryjordan.biz/forum
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WHY CREATE SUBCLIPS?

This illustrates the main reason we create subclips. The gap between the In and Out in this
screen shot is 5 seconds. The entire clip is 1 hour long. This gap is so small it is hard to
click between the marks and impossible to navigate.

Unlike audio files, we can't zoom into the timeline of the video tab of the Viewer.

Subclips allow us to create a new clip containing just the portion of the video between the In
and the Out, which makes navigation and editing much easier.

In the past, I never used subclips. Though it was more time-consuming, I captured all my
media in short segments. I would capture each answer in a Q&A session as a separate clip.
I'd capture B-roll in chunks by location. While this did give me more clips in the Browser, it
make it easier for me to find and review the clips I was looking for.

Now that we are working with tapeless media, each time we press the record key, a new file
is created. This makes capturing individual B-roll clips much easier, but converting a long
interview into individual answers more awkward.

Subclips can solve this problem.

Also, and we talked about this in last week's webinar on 3D Video, subclips are essential
when you are working with drop zones in Motion templates or image wells.

Unlike a clip you edit to the Timeline, clips that are dragged into a Motion template drop
zone or an image well in a third-party program like Red Giant Software's Primatte Keyer Pro
4 or Dashwood Cinema Solutions' Stereo 3D Toolbox, has no knowledge of In or Out, they
always start at the beginning of the clip.

Subclips allow us to create clips that start somewhere other than the beginning of the media
file and yet still work perfectly with drop zones or image wells.

CREATING SUBCLIPS

There are a variety of ways to create subclips. Let's start with the easiest.

1. Open your source video into the Viewer. 
2. Set an In where you want the subclip to start.
3. Set an Out where you want the subclip to end. 
4. Choose Modify > Make Subclip (or type Command+U).

Immediately underneath the source clip in the Browser the subclip appears. It is
automatically named with the name of the Source clip followed by "Subclip." You can, of
course, change the name to anything you want.

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=190
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NOTE: Subclips are automatically stored in the same bin as the source clip.
You can move subclips where ever you want -- just like a regular clip.

This subclip is derived from the source file, and the media file of that source file stored on
your hard disk. But, when you double-click it to load into the Viewer, the only media you see
is that contained between the original In and the Out you used to create the subclip.

Even though there is plenty of extra media in the source file, the subclip contains no handles
before the In or the Out.

There is no limit to the number of subclips you can create from a single master clip. As well,
media can be shared between subclips with no problems.

USING MARKERS TO CREATE SUBCLIPS

You can also use markers to create subclips. For instance:

1. Edit the source clip into the Timeline or Viewer
2. If you are in the Timeline, select the clip
3. Add markers throughout the clip where you want to create subclips.
4. Put your playhead between two markers and choose Mark > Mark to Markers (or

type Control+A). An In and Out are automatically created at the two marker positions
closest to the Playhead.

5. Choose Modify > Make Subclip (or type Command+U).

You can also use markers to create the equivalent of a subclip.

In the Browser any clip that contains markers has a triangle next to it. Twirl down the triangle
by clicking it to see a list of the markers contained in the clip.

Double-click a marker to load it as a subclip into the Viewer. At which point you can edit this
as any other clip.

NOTE: There's also a very cool way to create subclips from a group of clip
markers. Here's an article that describes how.

SUBCLIPS IN LOG AND TRANSFER?

By the way, when you use Log & Transfer to set an In and an Out on a longer
clip, you are not creating a subclip.

The reason is that Log & Transfer always creates new media files which are
then imported into Final Cut Pro. One of the definitions of a subclip is a clip
that does not contain media of its own, but only points to media contained in
other clips.

WORKING WITH SUBCLIPS

Once a subclip is created, you mark and edit it as though it is a regular clip.

http://www.larryjordan.biz/articles/lj_convert_markers.html


However, sometimes you may want to find the original source clip that the subclip came
from. For example, you may want to start a few frames before the In of the subclip. To load
the source file into the Viewer in place of the subclip:

1. Open the subclip in the Viewer
2. Park your playhead on the frame you want to find in the source file
3. Choose View > Match Frame > Source File (or type
Command+Option+F).

The source file is immediately loaded into the Viewer, with the playhead parked on the same
frame in the source file that it was in the subclip you started with.

The subclip is not altered by this swapping process.

If you just want to find the source file in the Browser, put your playhead in the subclip in
either the Timeline or the Viewer, then choose View > Reveal Subclip Parent Clip.

The source clip is highlighted in the Browser.

NOTE: In point of fact, freeze frames are special case subclips -- they are only
one frame long with a default two-minute length. If you ever want to find the
source file for a freeze frame, just put your playhead in the middle of the
freeze frame and choose View > Match frame > Source file (or type
Command+Option+F).

DELETING SUBCLIPS

Well, deleting actually has two meanings here. If you want to delete the subclip, just like
anything else in the Browser, select it and press the Delete key.

But, sometimes, you want to reset the subclip limits back to match that of the source clip.
Piece of cake.

1. Open the subclip in the Viewer.
2. Choose Modify > Remove Subclip Limits

The subclip becomes a normal clip, exactly matching the source clip from which the first was
taken.

As I work with longer and longer media files, and especially for 3D work, subclips are
becoming part of my daily routine. Also, for those who have been using Final Cut for a long
time, the stability of subclips has materially improved over the last several versions.

If you haven't experimented with subclips before now, they are definitely worth the effort to
learn.

UPDATE - SEPT. 21, 2010

Tom Wolsky adds:

[A subclip is] not quite like a regular clip. A significant distinction is that it is a
master clip so it can be renamed and other useful things.

To convert markers into subclips simply select the markers in list view [in the
Browser] and press Cmd-U or Modify>Make Subclips. No need use Mark to
Markers. You can also use extended markers [markers with durations] which
will be honored as subclip limits when the subclip conversion is done.

Some applications and application functions, like Speed and SmoothCam,
ignore subclip limits. Some wells may also.



Larry replies: Thanks, Tom. Much appreciate the additional information.

[ Go to Top. ]

THOUGHTS ON TEACHING TECHNOLOGY

I've been thinking about teaching recently. Now, this isn't
surprising since my principle role is training in one form
or another. Still, thinking about what I can do to make my
teaching better is always a worthwhile activity.

A lot of trainers and teachers read this newsletter, so I
thought it would be interesting to start a discussion.

Anyway, I've been reflecting recently on the challenges
in teaching technology. And I'm starting to think we may
not be doing it right -- or, more accurately, we may be making it harder for our students to
retain the right information.

I've never mentioned this in writing before, but the genesis of these ideas began a couple
years ago when I was at Apple for four days of training for Apple-Certified Instructors on the
latest version of Motion.

I could not believe how angry I was at the end of the first day of training. At the start of the
first day, we jumped right into 3D space and I promptly got lost. As the instructor said "click
here" or "your screen should now look like this" I got further and further behind until, at the
end of the day, I had no clue what we had covered.

Now for motion graphics folks, moving around in 3D space is probably old hat. But for those
of us who still have a love/hate relationship with Motion and develop skin allergies at the
thought of doing anything serious in After Effects, in other words, me, 3D was alien space.

What made this whole experience worse was that we were following the outline in the
Motion book. Since I know all the authors of the Apple Motion books, I am not pointing
fingers. Instead, this experience made me realize the difference between teaching a class in
person and teaching by writing a book.

Over the last couple of years, I've used this experience to differentiate the methods I use to
teach a class versus how I write a book.

In a word, in-class training comes down to overcoming fear.

When I write a book, or when I write a technique for this newsletter, I try to provide a precise
step-by-step cookbook for someone to follow. But I almost never do this when I teach a
class in person.

Someone purchases a book because they are interested in the subject and want to devote
the time to learning something. Books have to provide step-by-step instructions because the
instructor isn't there to answer questions. As authors, we need to anticipate questions and
answer them in the book. Assuming the book is well-written, if students get lost, they'll go
over the material again, or look for an alternate explanation elsewhere in the book, to regain
their understanding.

But in-class is different. Assuming the students are there voluntarily -- and I've taught
classes where they weren't very happy about being there -- why are they spending vastly
more money to attend a class in person, when compared to buying a book?

I think that one major motivating factor is fear. Fear that they aren't smart enough to
understand the software. Fear that if they can't learn it, they won't get work. Fear that this



knowledge they desire is just beyond their reach.

No student I've ever taught has expressed it this way. They use phrases like: "I want to make
myself more marketable," "I want to get a promotion," "I need to do more in less time;" but
their underlying concern is "what if I can't?"

For this reason, I devote lots of time during the first day to helping students feel successful. I
don't have them open the book, as I don't want them worrying about what page they should
be on, or why their screen doesn't look "right." In some cases, I ask them not to take notes,
just be in the moment and "do." The experience of getting something to work is far superior
to taking notes -- at least in the beginning.

Before launching any software, I always explain the principals behind what we are doing,
describe where we are going, and give them signposts they'll see along the way so they don't
get lost. (I'm a firm believer in building a strong foundation.) Once we start using the
software, I am never a stickler for accuracy. Not at the start.

Load a clip, I say. I don't care which clip. Set an In, anywhere. Set an Out, anywhere. Here's
a quick way to edit it to the Timeline. Done. Hit the spacebar and play it. Poof! YOU are an
editor! Very cool….

The problem I had with the Motion class wasn't the software, it wasn't the book. It was that I
was completely lost on the whole concept of 3D and while the book said "move the camera
here," the camera was like no studio camera I've ever worked with. I was lost in the details
and getting farther behind. I needed help understanding the big picture before I could
appreciate the details. I don't need to create glorious art on the first take. I just want to
create ANYTHING and know how I got there and how I can get back.

Take a minute and think about the software that scares you. It probably isn't editing software,
since you read this newsletter. Maybe it's accounting software, or databases, or design or
foreign languages.

Think about why it frightens you -- maybe you don't understand how it "thinks," or how it's
used in real-life, or your brain just "doesn't think that way." In other words, it has you
intimidated.

If students are intimidated by something, trying to get them to do it accurately is the worst
thing we can do. We need to help them feel successful, like they CAN learn this, before they
can put this knowledge to work.

If they have an affinity for the software, they will quickly start to demand more and more
detail. But only after we've given them the freedom to learn without penalizing them for
mistakes.

Get them oriented, comfortable, and successful and they become excited. They CAN learn
this. They CAN master it. Precision and details come with time. But they'll never spend the
time if they are angry at themselves for being too dumb to learn.

Let me know what you think. (For additional comments, I've also posted this to my blog.)

[ Go to Top. ]

A QUICK NOTE ON PLURAL EYES

I'm editing a corporate video shot by an essentially inept crew. To
give you an idea of what I'm working with, it was an outdoor
interview between two people. One camera was shooting a static
wide shot of a building while recording the audio of the interview,
while the second camera was recording the video of the two

http://www.larryjordan.biz/app_bin/wordpress/archives/1265


people talking, but only using the camera mike for audio. The
second camera was also located about 20 feet away from the
speakers.

it probably won't surprise you when I say that the operator of
camera one did not think it important enough to actually INCLUDE the people speaking in
his shot. Like I said, they were inept.

Naturally, they did not use a slate, nor did they start recording at the same time. How was I
going to get these synced? About the only way is to play both audio tracks at the same time
and adjust one until they slipped into sync. 15 - 20 minutes of my time wasted, at least.

Then, I remembered that I had PluralEyes installed on my system. For those of you that have
not heard of this product, it was specifically designed to sync clips and create multiclips
based upon their audio. However, it can also sync clips in a sequence -- even if there are
timecode breaks in the clips -- by aligning the audio.

To make a long story short, what I thought would take a long chunk of time to get these
stupid clips synced, PluralEyes did in 51 seconds - I timed it. And the sync was perfect.

I was a believer before. But now, I'm a fan.

You can read my detailed product review here.

You can learn more here: www.singularsoftware.com

[ Go to Top. ]

PLUG-INS IN USE: NEWBLUEFX

{To read my disclosure policy on product reviews, please click here.)

One of the fun tasks in creating my weekly webinars is learning all kinds of new products.
There are three that I want to highlight for you this month. The first one is NewBlueFx.

NewBlue (www.newbluefx.com) is new to the Mac, but
not new to creating effects. They've been providing
interesting effects to Windows users for several years.

They began in 2001, supplying video effects to the OEM market; that is, they sold to
companies that make products to sell to end-users. The founders of the company -- Todor
Fay and Melissa Jordan Grey (no relation) -- also founded The Blue Ribbon Soundworks in
1988 to create music and audio software. Bars&Pipes and AudioActive were their most well-
known products.

They now provide effects and transitions for Adobe Premiere, Adobe After Effects, Apple
Final Cut Pro, Avid Liquid, Avid Media Composer, Corel VideoStudio, Pinnacle Studio, Sony
Vegas, and Thomson Grass Valley Edius.

So they've been in the industry for a long time - but new to the Mac.

Recently, Sandy Berman, in their marketing department, contacted me to talk about their
new Mac effects plug-ins, marketed as NewBlueFX. Unlike some developers, they sell their
plug-ins in bundles of 10-12 effects per bundle. Price range from $79 to $139 per bundle.
They have transitions, filters, and image repair tools to choose from.

http://www.singularsoftware.com/
http://www.newbluefx.com/
http://www.larryjordan.biz/articles/lj_pluraleyes.html
http://www.singularsoftware.com/
http://www.larryjordan.biz/articles/lj_disclosure.html
http://www.newbluefx.com/


While they have over 100 effects to choose from, in this technique, I want to highlight three:

Transitions
Image repair
Filter effects

One of the hallmarks of NewBlueFX is a very easy-to-use interface with lots of choices. Let
me illustrate.

TRANSITIONS

They have five transition bundles: 3D Explosions, 3D Transformations, Art Blends, Motion
Blends, and Paint Blends.

Here's an example of a 3D Transformation transition. (By the way, it is REALLY hard to
capture a 3D move as a 2D screen shot…) This is transitioning from black into a clip.



Here's what the transition interface looks like. Very clean, with a modest number of controls.
The general philosophy here is to grab a handle, drag it, and if you like it -- use it.

Here are the presets available for one particular effect. All a preset does is adjust the
settings of the individual sliders in the transition. You can adjust the sliders yourself and save
it as your own preset. You access personal presets at the bottom of this menu using Load
preset...



So although there are about ten effects in each bundle, each effect has many different
presets, which means you have lots of options in how these look.

REPAIR FILTERS

They have three Video Essential bundles to pick from, each with a variety of effects. One
that I was particularly struck by was in Video Essentials 1, which contains an easy to use
color corrector and a filter that removes camera flashes from a video. (Think weddings…)

This is an amazing tool. When you apply the filter, it goes through your video, finding frames
which have been over-exposed due to flashes. Then, it copies the frame prior to it and
replaces the frame with the flash, making the flash disappear.

This technique works best on those images where the subject is not moving quickly,
otherwise you see a slight jump in the movement. But, for many scenes, this can be a life-
saver.

NOTE: I'm grateful to MintySlippers.com, a UK-based wedding videographer,
for permission to use this clip and the next one.

Here's how this filter works.

1. Select the clip containing the flashes you want to remove.

2. Apply Effects > Video Filters > NewBlue Video Essentials > Flash
Remover

http://www.mintyslippers.com/


3. Double-click the clip to load it into the Viewer.

4. Set the top popup to match the lighting of the room, in this case, it is neither
dark nor bright, so I select Typical.

5. Normally, you won't need to adjust Threshold as the preset does it for you.
However, if the filter doesn't sense flashes, tweak this a bit.

And that's it. As soon as you render the clip, all your flashes are gone!

COOL EFFECTS

When it comes to cool, interesting visual effects, there are tons to choose from. In the case
of NewBlueFX, most of their plugins would be categorized as visual effects. Rather than
simply list them here, I want to showcase just one.



Think of doing a wedding video, a romantic scene, or a dream sequence. We want to soften
the image to heighten the emotion. The image on the left was how it was shot, the image on
the right is after the filter. Here's how we got there:

1. Select the clip and apply Effects > Video Filters > NewBlue Video
Essentials > Soft focus

2. Double-click the clip to load it into the Viewer and click the Filters tab.

3. Change the popup from Soften to Dream.

As before, the presets in the popup simply adjust the sliders. You can achieve the same
effect by manually adjusting the sliders. Or, you can modify the effect by selecting a popup
and gently tweaking the sliders.

There are several things I like about the NewBlueFX effects:

Reasonable pricing
Selling bundles instead of individual applications\
The simplicity of their interface
The variety and look of their plug-ins.

However, I've had conversations with the company about how they bundle their products.
They are new to the professional video market and some of their selections, while great for
the iMovie set, have limited value in high-production-quality projects.

What I suggest they do, since they've already created the software, is look at creating
specific bundles for our industry. For example, a "Repair" bundle, a "Transitions Variety"
bundle, and a "Killer Look" bundle.

Still, if you haven't checked these folks out, they are worth your time. They have some
effects here that I haven't seen anywhere else.

[ Go to Top. ]



PRODUCT REVIEW: get

(To read my disclosure policy on product reviews, please click here.)

get, published by AV3 Software, was announced with great
fanfare about a month ago. As part of my webinar on Final
Cut Pro third-party effects they sent me a copy that I could
use for the session.

get searches your media files - specifically the audio part of
your media files - based upon text you enter in a search
box. The magical part is that you don't need to create transcripts first. Plus, once you find the
clips you are looking for, it is a single mouse click to load them into Final Cut Pro.

This is easier to show than explain.

This is the get interface. Before you can start searching, you need to index your files. get is
designed to index individual folders, rather than your entire hard disk. This is actually a
benefit, as you'll see below.

http://www.av3software.com/
http://www.larryjordan.biz/articles/lj_disclosure.html
http://www.av3software.com/
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=188
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=188


To index a folder, click the Plus button in the lower left corner and select the folder(s) you
want to index.

The benefit to indexing by folder is, say you have three documentaries that you are working
on at the same time. If you search for the words "we have a problem," you'll probably get
hits from all three shows. However, you are only looking for hits from the media files of one
show.

By specifying which folders to search in, you limit the results you are going to get.

While selecting folders to index takes a bit more time initially, after that, the indexing process
is automatic. get keeps an eye on every folder you initially indexed. If you add more media to
that folder, the new files are reindexed automatically.

NOTE: get is not designed to work on a server. Nor is it designed to index
network volumes. It works strictly with direct-attached storage. This indicates to
me that another product is in the works to provide network-wide indexing.

A small clock appears next to a folder that is being indexed. The clock slowly fills as indexing
progresses. When indexing is complete, the clock disappears.

I haven't done any formal timing tests but based on what I've seen so far, using an recent
model iMac, indexing media is about 20 times faster than real time, somewhat less than AV3
mentions on their website.



Once the indexing is complete, finding media is as easy as searching for text in a word
processor. First, you need to select the folder you want to search by selecting it from the
Search popup menu.

Here, for example, I am searching for the word "interplanetary" spoken by Dr. Vint Cerf as
part of a documentary on the future of the Internet.

NOTE: I am very grateful both to Dr. Vint Cerf and Alcatel/Lucent for
permission to use this interview.

I simply type the word, or words, I'm looking for. After less than two seconds, three clips
showed up.

NOTE: This illustrates the benefits of capturing interview answers as separate
clips. It makes finding and reviewing them much easier. However, get works
equally well with either short clips with single answers or long clips containing
multiple answers.



To review a clip, either double-click the name, or click the Preview Result button.

Notice that in the clip illustrated here, the word "interplanetary" appears three times. Each
appearance has a blue marker in the playhead scrubber bar, plus it is listed in the table
below the clip.

The buttons at the bottom allow you to easily move between the found clips, jump between
markers within the clip, even export the clip (more on that in a minute).

Let's say we want to use the portion of the clip where he says "interplanetary" for the second
time. While we COULD send the entire clip to Final Cut, it may be easier to simply mark the
portion of the clip we want to use.



                   

As in Final Cut, you can drag the playhead with the mouse, or press the spacebar to
play/stop a clip. Also like Final Cut, press I to set the In and O to set the Out.

To send the file to Final Cut, click the Export New Clip button in the lower right of the clip
screen.

NOTE: For this to work, both Final Cut Pro and the project you want to send
the file to must be open.

The Save File window opens and on the left is a list of all the projects currently open in Final
Cut Pro. Select the project you want to load the clip into, give the file a name, and click



Save.

As this screen shot shows, the file is exported to FCP, with markers placed where the word
"Interplanetary" occurs and including the In and Out that you set. (Setting an In or Out in get
is not required, but I wanted to show you that it could be done.)

As an alternative way of exporting clips, in the main search window you can select some or
all of the clips that were found, and click the Export New Clip button in the top right corner.

The Save File window appears. Give the files a relevant group name - in this case I used
"Cerf."



Each file appears as a separate file in Final Cut, but named using the group name plus a
number.

ADDITIONAL FEATURES

While not a big requirement as you are getting started, keeping
your searches manageable is important. There's no value in
searching for something if, everytime you search, it finds either
nothing or everything.

get allows you to limit your searches based on additional
attributes. It also allows you to index files stored in folders or
Final Cut Pro projects, save searches for reuse later, and modify
the threshold it uses to find matches.

The benefits to limiting your searches become significant as your
media files increase in number. We've all experienced the feelilng
that "I know it's here somewhere, I just can't remember where it
is."

Spotlight solves a lot of these searching issues, but not for the
content of media files. get takes over where Spotlight leaves off.

In the past, in order for us to find something we needed to take
the time - and effort - to add metadata to all our clips. A very
time-consuming process which we tried to ignore as often as
possible.

Now, get makes it possible to find stuff without metadata.

The only real negative to using get is that you need to index your
media files before you can search them. Well, that, and a retail
price of $499. Still, if you are drowning in files that you can't find,
it may be a cheap price to pay.



get is a truly amazing product. As I said during my webinar, get is
something very close to magic.

UPDATE - Sept. 26, 2010

Ben Balser adds:

[As part of writing an article for Event DV magazine, ] I actually did test it out
on an Ethernet networked volume, and it indexed just fine.

Larry replies: Thanks, Ben, for the update. This is good to know.

[ Go to Top. ]

PRODUCT REVIEW: prEdit

To read my disclosure policy on reviewing products, click here.

prEdit, published by Intelligent Assistance, is another
amazing product.

prEdit is a bridge product that combines the strengths
of Adobe Premiere and Soundbooth with Final Cut
Pro. And it supports Microsoft Excel, Apple Final Cut
Pro, or Adobe Premiere.

Here's the basic workflow:

Create text transcripts automatically in
Premiere.

http://assistedediting.intelligentassistance.com/prEdit/
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=188
http://www.larryjordan.biz/articles/lj_disclosure.html
http://www.larryjordan.biz/articles/lj_disclosure.html
http://assistedediting.intelligentassistance.com/prEdit/


Export the transcripts as an XML file
Review and edit the transcripts in prEdit as text files
Select the clips you want to build into a sequence
Export the selected clips as an XML file
Open that XML file in Final Cut Pro, or Premiere, as an edited sequence.

In other words, by using a transcript, you can do a rough cut of your actual clips, without
opening Final Cut Pro.

Imagine you need to save time, so you let a producer or production assistant do the first-
pass rough cut using only prEdit and an auto-generated transcript.

Instead of waiting days for the transcript to be produced, then tying down a Final Cut editor
for the rough cut, you can free up more expensive staff for the hard work of turning a rough
cut into a watchable program, while the producer, who may know the content better, starts to
shape the story.

This is amazing stuff!

Here's how it works.

Load the clips you want to transcribe into Adobe Premiere. (This feature requires Adobe
Production Premium CS4 or CS5.)

NOTE: If you have only one clip to transcribe, you can use Adobe Soundbooth.
The benefit Premiere provides is that it can process clips in batches.



Click the Metadata tab in the top center of the screen.

Then, in the Browser, select all the clips you want to transcribe.

With the clips selected, click the Analyze button in the middle of the screen (it's at the
bottom of the Metadata tab and part of the Speech Analysis section.

In the Analyze window, select the language the speaker is using, and set whether you want
High or Low quality.

Click OK and the transcription process starts.

The process itself take 2-4 times longer than real-time; which is MUCH faster than I can
type.



When the transcriptions are done, select a clip and the text of the clip appears in the Speech
Analysis window.

NOTE: Much has been written about the accuracy of these transcripts. I find
that if you ignore names and proper nouns, the accuracy is pretty good.
However, it isn't perfect. On the other hand, we are not writing a book, we are
editing television. My feeling is that if I can get enough of a sense of what the
speaker is saying to know whether I want to use the clip, the transcript has met
my purpose. And, if you exclude the cost of the software, the transcript is free
and far faster than any manual transcript.

Once the transcripts are complete, select all the clips you want to move over to prEdit, and
choose File > Export > Final Cut Pro XML This creates the file that prEdit can read to help
you pick your clips.

Open prEdit. In the top left corner, click the Import Clips XML button and select the XML file
you just exported from Premier (or Soundbooth - the process is the same).

The popup menu just below the import button lists all the clips you just transcribed.

Select the clip that you want to work with.



The text of the clip appears on the right, the logging information appears on the left.

Click once on the text and it highlights. Click a second time and the text becomes editable.
Put your cursor at the beginning of the clip you want to use and press Return.

This creates an In for the clip. Find the text at the end of the clip you want to use and press
Return again. This sets an Out. Click the Color popup menu to set a color for the selected
clip.

Notice how each clip segment has a thin gray line above and below it? This indicates the
duration of the marked clip.



Select the text for a clip you want to use and enter relevant metadata in the fields on the left.

The most important field to enter is the Person field, where you enter the speaker's name. It
is in the middle of the right-hand column. You'll see why shortly.

Repeat this process for all the clips you want to use in your rough cut.

Click the Story View button in the top left corner.

This displays all your clips in the left column. Where you entered the person's name, you
see it on the left. This is the indicator for the clips you marked earlier.

Skim through the transcripts on the left. When you find a clip you want to use, drag it from
the left side to the right.



As you do, a thumbnail of your clip is displayed, along with the relevant transcript.

Grab clips and drag them up or down to put them in the order you want. Click the Remove
button if you want to remove a clip from your edit list.

If you want to watch your clips, click the Preview Story button in the top right corner. This
allows you to see what you are creating and make minor trims to the In or Out of the clips



When you are happy with the order of your clips - and remember this is just a ROUGH cut,
so don't obsess too much at this point - click the Export button in the lower right corner.

From the settings menu, make sure your video settings are correct and tell it what software
you want the information exported to. I was very impressed with its support for Excel, Final
Cut Pro, and Premiere!

NOTE: Be sure Final Cut Pro is open, in which case this process is almost
instantaneous.

Final Cut Pro then opens a dialog asking how you want the XML file imported. If you only
have one project open, the defaults will all be correct.



A folder named after your Premiere project is loaded into the Browser. Twirl it open and
you'll see a new sequence, also named after your Premiere proejct, and all your exported
clips.

Load the project file into the Timeline and there are your selected clips, edited in the order
you specified in prEdit!

Notice the red markers with durations at the top of the sequence?



Put your playhead in any marker and you can see the transcript of what your speaker is
saying at that instant!

This is flat-out incredible! As I told Philip Hodgetts and Greg Clark, the two developers,
prEdit is stunningly sexy!

If transcripts, documentaries, and tight deadlines are part of your life, you need to check into
prEdit.

[ Go to Top. ]

PASSING THOUGHTS

Short items of passing interest…

LATEST NEWS

For all the latest news on our industry visit the Latest News section of the Digital Production
Buzz.

POSTAPALOOZA HAPPENS ON OCT. 10

Steve Julin sent this:

Mark your calendars for this year's premier post-prodcution conference,
Postapalooza. This two-day conference starts on 10.10.10 and offers over 30
different editing workshops. Topics range from After Effects to Pro Tools.
Register early and save $$$.

The conference is held in Mt. Pleasant, MI at the Soaring Eagle Resort and
Casino. A block of discounted rooms are available for a limited time.

Visit www.cleverscope.net to learn more and register. This year's grand prize is
a brand spanking new Apple iMac!

http://www.digitalproductionbuzz.com/news
http://www.digitalproductionbuzz.com/
http://www.digitalproductionbuzz.com/
http://www.cleverscope.net/


Sony has a new camera -- part video, part stills

http://www.luminous-landscape.com/reviews/camcorders/vg10.shtml

This is their answer to the DSLR phenomenon.

KenStone.net has new articles:

Using the Roto Brush Tool - in Adobe After Effects CS5 by Steve Douglas.
http://www.kenstone.net/fcp_homepage/rotobrush_ae_cs5_douglas.html

SOHOTANK ST8 Stardom Storage Solutions - Review by Shane Ross
http://www.kenstone.net/fcp_homepage/sohotank_ross.html

Brian Roe sent this in:

I'm not sure if you have heard of this company or have seen their product
before but it seems interesting. I saw them advertised in Videomaker Magazine.
Check them out:

http://www.ssontech.com/synovu.htm

Brian Rapsey writes:

From rural Australia...

I've started mixing in final cut pro from my iPhone using this AP. Works well,
like a Tascam 1084 -

http://itunes.apple.com/au/app/proremote-light-edition/id286633892?mt=8

[ Go to Top. ]

READER MAIL

To get your questions answered, please visit my Forum at www.larryjordan.biz/forum.

CLOSING THE GAP

Steve writes:

Wasn't sure if this was on your site anywhere but I'm at work and we keep
encountering this with FCP7.

The close gab function keeps jumping to the first gap no matter where you are
on the timeline. I could swear I read a solution to this problem but it was not
on your site - I believe it was elsewhere and I can't find that article.

Have you encountered this? I keep getting asked but don't have a solution.

Larry replies: This was a known bug in FCP 7.0.2, which was fixed in the latest 7.0.3
release.

[ Go to Top. ]

BOOKING WORK

http://www.luminous-landscape.com/reviews/camcorders/vg10.shtml
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Ben Balser asks:

I personally advise up-and-coming videographers to get a contract template (I
had a lawyer friend do one for me, and it's been tweaked over the years by
her) and use it for every single job they do. Someone mentioned the other day
there were situations they'd not bother with a contract, and just a handshake
and an invoice (the invoice does not specify scope of work, just the title of the
work and price). I was curious as to what your take on this was. Maybe in the
newsletter or something.

Larry replies: Ben, this is a great question.

For large projects, I advise a contract.

For small projects, a detailed email memo describing the work, deadlines, and payment is
most often sufficient -- contracts are definitely the best way to go, but sometimes overkill if it
is only a few hundred dollars.

In all cases, I urge constant communication between you and the client to solve problems
before they become big ones.

I'll also invite other readers to share their thoughts. We'll also be talking about this on this
week's webinar.

[ Go to Top. ]

QUESTIONS ON TRANSCODING

Randy Holman asks:

In one of your tutorials you indicated ProRes422 only worked with 23.98 29.97
and so on. I have footage that was shot at 30P on a Canon 5D.

In a previous communication with you, you indicated I should transcode to
ProRes from the 5D, for editing.

I'm a little confused.

Is there a special consideration I need to be aware of, or a special setting I
need to make?

My file sizes from the captured media on the 5D are 4.7 times larger than the
h-264 from the camera, does that sound right?

Also when transcoding would you still turn on re-compress frames? I believe
the footage is already in I frame or does the H-264 change that?

Larry replies: Randy, if I said that ProRes only works with certain frame rates, I apologize, for
that is not correct. It supports all known frame rates.

Converting your 5D to ProRes is straightforward, as I've done it myself. Be SURE to get the
free EOS Movie Plug-in from Canon that allows you to use Log & Transfer for the process.

And, yes, ProRes is bigger, but provides much faster compression and higher image quality,
especially for effects.

And, H.264 is definitely not I-frame based, which is why it is so tiny.

Keep in mind that if you use MPEG Streamclip to transcode your media, all your timecodes
reset to hour 0. If you use the EOS Movie plug-in, your timecodes will match time of day
when the recording was made.

http://www.larryjordan.biz/sem/webinar_2010b.php
http://www.larryjordan.biz/sem/webinar_2010b.php


UPDATE - Sept. 26, 2010

Ben Balser adds:

I deal with this a lot. "ProRes file sizes are huge!" Well, honestly, they're not.

Let's work with uncompressed HD, or DVCPRO-HD, any HD video format that
is not Long-GOP, and that is "normal size" files for HD video. MPEG-2 and
H.264 are actually TINY, TINY file sized, and very highly compressed, and
have all the headaches, um, "issues" of Long-GOP video file workflow. So
rather than think these highly compressed files are "normal", let's clear the air,
they're not normal HD video file sizes, they're super tiny, very compressed.

Also, in reviewing the Canon EOS Movie plugin for FCP's Log & Transfer
process, it is quite a bit faster than using Compressor (Canon enhanced the
algorithms to make it faster), and I've found, as fast, if not a tiny bit faster than
MPEGStreamClip. Not to mention all of the other benefits you mentioned. And
I'd like to ask you about one other issue on this subject. I know a few
professional videographers out there using MpegStreamClip to convert the
Canon DSLR H.264 files to XDCAM and other MPEG-2 file formats. What's the
purpose? I don't get it. Why convert to another Long-GOP format, which will
risk losing image fidelity/quality in the process? I'd love to hear a valid
professional reason for this.

Larry replies: Thanks, Ben, for the update. I agree that using the Canon plug-in is the best
way to work with DSLR footage.
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CHOOSING A GRAPHICS CARD

Will Vafides writes:

Hi Larry, I have watched your tutorials and I learned a lot from them so I
wanted to say thank you for that. My questions is if you were to choose a
graphics card using a mac pro for Final Cut Studio 3, which would you choose
a NIVIDA or ATI and why?

Larry replies: Will, thanks for writing.

I have no opinion - since FCP doesn't really support graphics cards, yet. However, the
current trend seems to be toward nVidia.

Motion does support graphics cards, however, and so does the Adobe Production Premium
suite. So if those applications are important to you, get the fastest graphics card you can
afford. For FCP, any graphics card will be fine until Apple ships a new version.

Be SURE to check both Apple and Adobe's website for supported cards. Not all cards are
supported. For Final Cut, visit: www.apple.com/finalcutstudio/resources.

UPDATE - Sept. 26, 2010

Ben Balser adds:

You say, "...FCP doesn't really support graphics cards..." Actually, it does. OK,
I'm nit picking here, but I can't resist. Any of the FXPlug based plugins brought
over from Motion do access the GPU. But will anyone notice? Probably not.
Just a technical nit pick, but, oh, never mind...

Larry replies: Ben, you are correct that PORTIONS of Final Cut work with the GPU. However,

http://www.apple.com/finalcutstudio/resources


at this point, it is also true that the entire application does not yet support it.
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TIMING OUT AND SPINNING BEACH BALLS

Mary Lou Sheets asks:

I'm working on a project in FCP. When I leave the program up for an hour and
fix dinner and eat when I come back, it says FCP timed out. I have to quit FCP
and sign back in. Why does it do this? Is there any way to stop it from doing
this?

2nd question. When I'm working in the time line I'm at the beginning. Then I
move my cursor to the end fast, a color ball keeps spinning and sometimes it
knocks me out of FCP why? I know you can't go fast from one part to the
other, is there any way to stop this besides going super slow?

Thanks for your help.

Larry replies: Mary Lou, there's something more seriously wrong here... FCP doesn't "Time
Out."

Time out's only affect network volumes and internet access. FCP should be installed in your
applications folder, which you have full access to all the time.

How are you opening FCP? Where are your project files stored? It sounds like either Final
Cut or your computer were not set up correctly.

Your second question seems to indicate you are accessing video media over a very slow
network. You should store media locally, on an external hard drive, not on a server -- unless
you have a very fast network.

Also, your computer may not have a fast Ethernet connection.

The Time Out is probably due to your network. The spinning beach ball is almost definitely
due to storing media on a slow server or accessing via very slow network connection.
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IS 60I THE SAME AS 30P?

Chris Gibbs asks:

I've been a stills guy for over 20 years and understand that side implicitly, the
film part is new to me and I have a question about SONY's implementation of
60fps interlacing in some of their products?

I've been told that SONY uses the 60i format as a wrapper and that the file is
actually a 30p (progressive) inside there, just ready to be extracted as 30p in
FCP??????

My concern Larry is this, I'm shooting multi-media on the Canon 5Dmkll and
want to augment my 5Dmkll stills AND video with footage from a small
handycam like the Sony. But I'm concerned about mixing & matching the Sony
60i footage (whatever they actually are) with my Canon 5Dmkll 24p/30p frame
rates in Final Cut Pro.

I do not want to make a lot of extra steps for myself by trying to mix this SONY
60fps interlaced with Canon's progressive format if I can help it!



Larry replies: Chris, this is not, ah, completely true.

A 60i format shoots 60 fields a second, which get combined into 30 frames a second. Each
frame consists of two fields, each 1/60th of a second apart. This time difference is what
causes all the grief in dealing with interlaced images on the computer, which displays all
images progressively.

Since before you were born, every program we have ever watched on standard definition TV
is interlaced -- it was part of the format invented back in the 1930's. There is nothing
inherently wrong with interlacing - UNTIL it gets displayed on a computer, at which point, it is
a disaster.

So, while a frame consists of two fields all wrapped together, it is not progressive, since the
two fields are shot 1/60th of a second apart. A true progressive frame is when all lines of the
image are shot at the same time. Most Sony cameras, and all their low-end systems, do not
shoot progressive -- except, maybe, at 24 fps.

And, while I should never say never, you are going to have a great deal of problems
matching images between your Canon 5D and the Sony Handy-cam. From colorimitry, to
depth of field, to quality of lens, to image clarity, to compression ratios, to ... oh, I don't know,
pick anything... these cameras won't match.

Yes, you can get them to resemble each other - but how much time do you want to spend in
editing?

The differences between these two cameras are so great, that progressive vs interlacing is
the least of your problems.

My suggestion is to rent or borrow the Sony camera, shoot it, and see what you think. If you
didn't have the Canon, you'd probably like it - because it looks like what you think video
looks like. After you see the Canon, you won't.
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SAVE MY LIVETYPE

Dick Osso writes:

I have a reason to upgrade to FCP 7. Need to create BLURAY DVDs from Hi
Def footage.

ISSUE

I REALLY LOVE my store bought fonts I now have in Live Type in FCP6. I
don't know how or where and it may have been in your discussions, but other
people have raised the same request.

HOW DO I SAVE MY LIVETYPE CURRENT SETTINGS and not lose them
when I upgrade to FCP7 ?

Can I just download FCP and MOTION and not LT ?

If you have or know of a printed WORK AROUND on this issue, that would be
mostly appreciated.

Larry replies: Dick, this isn't a problem.

When you upgrade to FCP 7 it does not remove your LiveType appication, fonts, or textures
from your system. So, go ahead and upgrade.

If, for any reason, you need to reinstall LiveType, you can do so on an FCP 7 system by



installing LiveType from your Final Cut Studio 2 disks.

I've done this on several systems, all with no problems.
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CONVERTING HDV TO DVD

Gerry Fraiberg writes:

In your article "Converting HDV Video for a Letter-Boxed DVD" you suggest
"import your movie into DVD Studio Pro and place it on a 16:9. This displays
your movie at 16:9 on TV sets that support 16:9, and automatically letter-boxes
your movie that only displays 4:3."

My question is, what do you set preferences at in DVD Studio Pro - 16:9 Pan-
Scan, 16:9 Letterbox or 16:9 Pan-Scan & Letterbox?

I shoot HDV at 30P on a Sony Z5U, deliver to client on SD DVD.

Larry replies: Hmmm... Let me be clearer.

You can NOT have DVD SP convert HDV video to SD. It doesn't know how to transcode it.

You need to convert it to SD first using Compressor, then bring the files into DVD Studio Pro.

To keep the 16:9 format, select 16:9 Letterbox in the DVD Studio Pro Inspector.
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SIZING GRAPHICS FOR DVD

Steve Nave asks:

I want to tell you I have been watching your videos on Lynda.com and really
enjoy your teaching style and content you have prepared. I have 2 questions,
you give the size of 4:3 graphic for graphics at 720x534x72, but I can't find the
size if I am using 16:9. Could you tell the graphic dimension for that?

And I went through the process of creating a 3 layered graphic for a menu in
Photoshop Elements 8 and had no problem, but when I import it into DVD SP
the text and black outline for the button is faded and not sharp like the
background graphic. Looks like low resolution. Any tips for what i may be doing
wrong? I tried both tiff and png. When I imported the tiff I couldn't access the
layers as well. When I saved the file in Photoshop, I did check the box to
include layers.

Larry replies: Thanks for writing, Steve.

16:9 menu graphics are 853 x 480 x 72.

FCP does not support Photoshop layer effects. Be sure to render / rasterize all layers before
importing into Final Cut.

UPDATE - Sept. 22, 2010

Chi-Ho Lee adds:

This is in response to the reader's question below - If you merge a PS layer
that contains a effect with a blank layer, then FCP will recognize that PS layer
effect. At least it used to back in FCPv4 and 5, haven't used layer effects and



FCP in a while but worth checking out.

Larry replies: Chi-ho, this is a good comment. However, my understanding is that merging
layers is also rasterizing the text as well as combining the layers.

So this gives us two ways to accomplish the same thing.
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TEXT IS TEXT, RIGHT?

David Gates writes:

I'm really confused about text in video.

Have a client that is publishing a book - she had them send me the page
layouts to use,.. but they were PFD files, and the weight of the lines
surrounding some paragraphs of the book were FINE for print - but crap for
motion graphics (as well as the size of the text she used - which again was
fine for output for a book, but NOT dealing with scanning lines/refresh rates for
TV - especially HD).

So here's the question -- is text then which is created at 80 points the
equivalent of 80 px?!?!

So what is the equivalent and/or difference between dpi vs ppi..... (dots per
versus pixels per...)

And does it make a difference if that 80 point letter is created within a
resolution of 440 or 1080?

Larry replies: David, this gets very confusing very quickly.

Text is text, however, the resolution of the text varies by device.

Video is a VERY low resolution device. Print is a high-resolution device. So, text that looks
good in high-resolution, such as thin lines, curved text, look very poor in video.

All forms of video are bit-mapped. This means the dpi and ppi are NOT relevant, only the
total number of pixels across by total number of pixels down count.

For an SD image, your pixel count is 720 x 480.

For an HD image, your pixel count is either 1280 x 720 or 1920 x 1080.

Why is DPI irrelevant? Imagine watching your video on a 13" monitor. Now imagine watching
it on a 60" display. The pixel density is different, because the total number of pixels is fixed.
To fit into a smaller display, we squeeze more pixels per inch. To fit pixels into a larger
display, we enlarge the pixels, making them taller and fatter. This is why video on a large
monitor looks grainier than the same video on a smaller monitor. You are changing the SIZE
of the pixels, but not the NUMBER of the pixels.

Ignore lines of resolution. It will only confuse you. Think only of pixels.

Remember - the total number of pixels across or down does not change, even as the
monitor size changes. You can not make an HD image by displaying an SD image on a
larger monitor.

Total pixel dimenstons are fixed.

In video, but not in print, pixels and points are synonymous.



In print, the number of pixels that make up an image is a combination of resolution and point
size. However, it is a true statement that a 100 point letter at 600 ppi will have FAR more
pixels than a 100 point / pixel letter in video.

Scanning at higher resolution for photographs is fine if you are doing moves on the images,
but not fine for creating text.

A 1 point line in print, will be about 10 pixels thick at 600 ppi. In video, that same line is only
one pixel thick. And, in an interlaced format, it will flicker on and off.

So, in video, ignore dpi, ignore ppi, and ignore lines of resolution.

In video one pixel equals one point. (In fact, this is what your computer screen does as well.)

Technically, the scanned graphics will never look good. They assume the device you are
viewing them on has the same resolution as a printing press. Video has less than 10% of the
pixels of print.
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MISSING MEDIA IN DVD STUDIO PRO'S PALETTES

This is a summary of a discussion on a recent Final Cut Pro listserv.

Question

I have been using DVDSP for years and have never experienced this before
and now it's happened to 3/4 of my class. None of the usual outlets have
provided an answer either (creative cow, etc...).

The content is not visible in the palette. You can trash prefs and the content
shows up for NEW projects, but when you open up existing projects they
disappear.

Answer

I have had this happen twice in my career. I do not know why but essentially
anything in the palette is a "pointer" to the location of the external assets.

In my 2 instances I duplicated the asset folder, renamed it significantly
(not just **_r1").

Import this new folder.

Never had a explanation. Hope this helps...

Larry adds: I've never tried this, but thought it might be helpful to some of you.
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CONFUSED ABOUT DATA RATES

Robert Guzy writes:

I recently purchased your 1 hr Webisode on Compression using Compressor. It
was excellent but left me with a few questions. I am confused by the Data rate
info.

Example:
I have been given the following spec: video= 500 kbps-1 Mbps.

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=182


When using Compressor it seems that the only control I have is in the video
settings>Data Rate restrict which is given as ...kbits/sec. When I create an
H.264 file of a 4:47 sec DV QT file and set above Data Rate Restrict at 900
kbits/sec I end up with a file of 36.6MB (36,593,794bytes)

My confusion is how all these numbers relate as (MB,kbps, kbits) all seem to
be different info, but nowhere is there a constant that is common between all.

How do I know that my 36.6MB file fulfills required spec. of 500kbps-1Mbps

Larry replies: Bob, data rates, too, are very confusing because of a single letter.

The constant is "bps" -- which stands for "bits per second."

Thus, "kbps" is "kilo bits per second" -- 1,000's of bits

And, "mbps" is "mega bits per second" -- 1,000,000's of bits.

So, their requirement of 500 kbps to 1 mbps translates to "500 - 1,000 kbps."

Your compression setting of 900 kbps falls perfectly into that range.

36 MB for a 5 minute files seems to me to be reasonable in size -- assuming your frame
size is something like 640 x 360 or so.

If you CAPITALIZE the "Bps" -- now you are talking "Bytes per second". This is the normal
way of measuring hard disk speed, but not the Internet.

"bps" / 8 = "Bps" -- confusing, I know, but that's the way it is...

As I tried to stress during the webinar, Compressor doesn't care what format your media
starts with. SD or HD, is all the same. What you are doing is specifying how you want it to
end up. Thus, you change the setting in the Geometry tab to determine the final image size
of your compressed file.

Hope this helps.
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CONFORMING VIDEO

Susan Utell asks:

When I render a green timeline I am getting a message box that says
"conforming mpeg-2 video". I haven't seen this before.

The project was brought in as XDCAM 422 1080i 60.

Should I be concerned?

Larry replies: No. And thanks for asking!

Formats like HDV and XDCAM are compressed using MPEG-2 which is very hard to edit
accurately. So, Final Cut Pro converts it invisibly into something easier to work with. This
means that part of the process of rendering and exporting involves converting them back into
MPEG-2 files.

This process is called conforming and is perfectly OK. Jus time-consuming.
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RUNNING COMPRESSOR FROM THE COMMAND LINE

Bob Gobeille sent this in:

I'm sure you don't remember me but you published my instructions for how to
refresh disk drives a couple years ago. I still enjoy your newsletter. Thank you.

On one of my jobs I just discovered that we incorrectly compressed ~3,500
videos (we sell stock weather video). This was at first a little depressing, but
then I looked into and found that Compressor could be run from the command
line. I haven't seen this talked about a lot, but maybe I've just missed it. The
instructions are simple and in the Compressor manual. Since I'm a computer
programmer, I used the command line to automate rerunning the ~3,500
compressions.

I just thought I'd mention running Compressor from the command line in case
others have some programming skills (or staff) and find themselves in a similar
circumstance.

I should have mentioned that when you queue up several hundred
compressions, that the Batch Monitor can consume as much cpu as the
compressor itself and become unresponsive. So try to avoid the Batch Monitor
or limit your batches to just a few hundred compressions (400 worked well for
me on a an older MacPro).

Larry adds: Thanks, Bob, for the tip!
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RENDER TIMES AND FILTERS

John Carter asks:

Great Presentation in August at WEVA.

Question, what should my RT setting be or sequence or even any other
preset? Once I applied a filter I get a orange line w/ unlimited for 20 hours to
render vs safe red line rending time of 3 hours.

Is this normal. I thought render time would be quick with these filters. 35 min
timeline using color fixer (100% of sequence), flash reducer( 3 min clip) and
noise reducer.(80% of the sequence)

Larry replies: John, thanks for the question.

The RT setting won't make any difference in the render times. Also the time estimates FCP
makes at the beginning of a render are notoriously inaccurate.

The speed of rendering depends upon a number of factors:

1. The speed of your computer's processors
2. The video format you are using - HDV and XDCAM are notoriously slow
3. The complexity of the work being performed by the filter
4. The amount of material being rendered

Render files are always created to match the format you selected for your sequence.
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EXPORTING VIDEO FILES FROM KEYNOTE



Chris Eschweiler sent this in:

As I was catching up on past episodes of the Digital Production Buzz, I came
across your suggestion to use Keynote to create text animations to drop into
Final Cut.

In that May 27th episode, you said that the finished animations give you just
one final frame that you can stretch out to achieve your desired duration.

I writing to say that it *is* possible to get the duration you desire from within
Keynote.

After you've created your slide in Keynote, go up to the Inspector and select
the second pane, "Slide Inspector." In "Transition, " select your desired
effect...say, Dissolve.

Under the Start Transition drop down, change the option to "Automatically" and
choose the amount of time you want the finished build to hold under "Delay."

When you export your text animation to a movie file, the text will build, hold,
and dissolve just exactly as you programmed.

I do this sort of thing all the time for clients...including your esteemed co-host,
Mr. Michael Horton who is currently in Holland ramping up the third annual
Amsterdam Final Cut Pro User Group SuperMeet. </shameless_plug>

Keynote is a really great program...a "poor man's Motion." And for $79 it's a
powerful, yet inexpensive, addition to the editor's arsenal.

Larry adds: Thanks, Chris, for sending this in.

UPDATE - Sept. 22, 2010

Nicolas Nilsen adds:

Hi Larry



In your last Newsletter, at the bottom, under the title "EXPORTING VIDEO
FILE FROM KEYNOTE" Chris Eschweiler talks about the way you (Larry) use
"one final frame that you can stretch out to achieve your desired duration".

Chris says it can be done within Keynote. Of course it can be done the way he
describes. It's possible and easy. But the problem is that it costs a lot in terms
of FILE SIZE.

If the "desired duration" is done from inside Keynote (the way Chris suggests)
it's video time.

If you do it with a "Freeze frame" from inside FCP, you can make it as long as
you need (stretch it as long as you need), and it DOESN'T COST A THING in
terms of video file size.

"Freeze frame" is LIGHT. "Duration" in Keynote is HEAVY

Larry replies: Nicolas, thanks for your comment. I totally forgot about the difference in file
sizes between these two methods. Thanks!

UPDATE - Sept. 26, 2010

Ben Balser adds:

I'm surprised more FCP users are not taking advantage of Keynote as a very
cool, very easy motion graphics tool.

But, as for the issue of stretching out a still as a freeze frame in FCP, as
opposed to having a slide linger for awhile in Keynote, here's my take. Yes, the
original Keynote generated QT file will be technically larger if you extend the
time in Keynote, but by how much? Not much at all. A few seconds is not
going to double the file size, or even increase it by much at all. Output from
Keynote won't be extended by much time, either. I don't think it's enough of a
difference to make any argument to not do it in Keynote. Besides, Keynote is
creating fresh frames of the original image for your QT movie. FCP is
duplicating frames. I'd rather keep the image fidelity created from Keynote.

Larry replies: Ben, the file sizes CAN be significant if you need lots of video between
transitions. My vote still rests with creating still frames in Final Cut, rather than trying to
precisely time segment durations in Keynote. Still frames will look as good and be MUCH
faster.
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WRAP-UP

Well, that's about it for this issue. I'm still wading thru all the email. Feel free to use my
Forum for questions. That way, we can all learn from each other.

For current news and in-depth interviews on what's happening in our industry, be sure to
listen to the Digital Production BuZZ every week.

Also, please consider supporting this newsletter by:

Registering for one of my webinars.
Buying a tutorial - decrease your stress and get back to work.
Or, buy a mouse pad -- you know you need a new one...

Also, please continue sending me your comments and questions. I love hearing from you and

http://www.larryjordan.biz/forum
http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.larryjordan.biz/sem/webinar_2010b.php
http://www.larryjordan.biz/training/online_tutorials.html
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=162
mailto:larry@larryjordan.biz?subject=Newsletter comments


enjoy the conversations that develop around your comments.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter!
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sign up at www.larryjordan.biz/newsletter.
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The information in this newsletter is believed to be accurate at the time of publication.
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these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter
has not been reviewed or sanctioned by Apple or any other third party. All trademarks
are the property of their respective owners and are mentioned here for editorial purposes
only.
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